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In this session you will: 

 gain an understanding of SmartArt 

 learn how to insert a SmartArt graphic 

 learn how to insert text into a SmartArt graphic 

 learn how to indent text 

 learn how to change the SmartArt style 

 learn how to change colours in a SmartArt graphic 

 learn how to change the layout of a SmartArt graphic 

 learn how to add more shapes to a SmartArt graphic 

 learn how to resize a SmartArt graphic. 

SmartArt refers to the range of graphics available in Word that you 
can use to create diagrams such as flow charts, process charts, 
organisation charts, and the like. Select a SmartArt graphic from the 
gallery and then customise it to suit your needs. SmartArt helps you 
to create professional-looking diagrams in minutes. 

INFOCUS 
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UNDERSTANDING SMARTART 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

SmartArt allows you to visually communicate 
important ideas and information. For example, 
you can use SmartArt graphics to depict 
processes, hierarchies, relationships and so on. 

By using SmartArt to communicate information, you 
can create visually-appealing diagrams that can 
say so much more than words alone. 
 

How To Use SmartArt 

SmartArt can be a simple flowchart depicting a process or a complex 
arrangement of shapes and lines used to show relationships. To work 
with SmartArt, simply select a layout from the SmartArt gallery that 
most closely represents the way you want to structure your information, 
and then customise the SmartArt graphic by adding text and formatting 
shapes. The picture to the right is an example of a SmartArt graphic 
used to list a range of complementary fuels. Presented in this way, dry 
subject matter suddenly becomes an interesting read.   

The SmartArt Tools: Design tab  

When you insert SmartArt into your document, two tabs appear – SmartArt Tools: Design and 
SmartArt Tools: Format. The Design tab allows you to edit SmartArt by adding shapes, bullets or text 
and shuffling shapes around by promoting or demoting them. It also allows you to choose alternative 
layouts, colours and styles to the default setting. If you change your mind about the changes you have 
applied, you can easily revert back to the default state by using the Reset Graphic option in the Reset 
group. 

The SmartArt Tools: Format tab  

The SmartArt Tools: Format tab, as displayed below, allows you to make shapes larger or smaller, 
change the colour of the outline or fill of your shapes and add effects to the shapes and/or text. You 
can also position your SmartArt on the page. 

 List: For items without a sequence, 
such as a list of key objects or 
concepts. 

 Process: For items or steps with a 
specific sequence and end point. 

 Cycle: For steps with a continuing 
sequence. 

 Relationship: To illustrate 
relationships between things, such as 
objects and people. 

 Matrix: For grid-like diagrams. 

 Pyramid: For a hierarchy of items, like 
the traditional food pyramid. 

 Picture: To create picture galleries and 
collages, for example. 

 

The SmartArt Gallery 

SmartArt graphics are available from the SmartArt gallery. 
Click on a category in the left pane to view a range of 
layouts for that category in the centre pane. Click on a layout 
to preview it in the right pane. 

There are eight categories of SmartArt graphics in the 

Left side of the SmartArt Tools: Format tab 

 

Right side of the SmartArt Tools: Format tab Sam
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INSERTING A SMARTART GRAPHIC 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

To create diagrams using SmartArt graphics, you 
first need to open the SmartArt gallery. You then 
select a layout from one of the eight categories 
that will best depict the information you want to 

convey. Once you insert the graphic, you can then 
insert text and format the shapes as required.  

Try This Yourself: 

O
p

e
n

 

F
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e
 Before starting this exercise 

you MUST open the file 
SmartArt_1.docx… 

 
Move to page 2 and position 
the insertion point in the 
space between the heading 
Research and the paragraph 
above 

The SmartArt graphic will be 
inserted here… 

 
Click on the Insert tab, then 
click on SmartArt in the 
Illustrations group to open 
the Choose a SmartArt 
Graphic dialog box 

 
Click on each category under 
All in the left pane, then click 
on various layouts in the 
centre pane to preview them 
in the right pane 

 
Click on the List category in 
the left pane, then click on 
Vertical Box List in the 
centre pane to select this 
layout 

 
Click on [OK] to insert the 
SmartArt graphic 

The graphic is contained 
within a placeholder and the 
top [Text] placeholder is 
selected, ready for you to 
start typing… 

 
Click outside the placeholder 
to deselect the graphic 

 

2 

6 

For Your Reference… 

To insert a SmartArt graphic: 

1. Click on the Insert tab, then click on 
SmartArt in the Illustrations group 

2. Click on a category in the left pane  

3. Click on a layout, then click on [OK] 

Handy to Know… 

 Choosing a SmartArt layout is just a starting 
point for your illustration. You can add or 
remove SmartArt objects and text as needed 
and the elements in the diagram will resize 
automatically. 
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INSERTING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Text is inserted into text placeholders within the 
corresponding shape. There are two ways to 
insert text into a SmartArt graphic. You can click 
on the [Text] placeholder and start typing, or 

display the Text pane and type your text into it. 
Typing text into the Text pane is generally the 
quicker method as you don’t need to select each 
shape before you type your text.  

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
SmartArt_2.docx... 

 
Click on the SmartArt 
graphic, then click on the 
tab on the placeholder’s left 
border to open the Text 
pane, as shown 

Each bullet point in the Text 
pane corresponds to a 
shape in the graphic... 

 
Click on the top bullet point 
and type Research 

The text appears in the 
corresponding shape in the 
chart... 

 
Press  to move to the 

next bullet point and type 
Pre-Construction 

 
Repeat step 3 to add 
Siteworks to the third 
shape 

 

1 

For Your Reference… 

To insert text into a SmartArt graphic: 

1. Click on the SmartArt graphic to display the 
placeholder, then click on the tab on the left 
border of the placeholder 

2. Type the text, using the arrow keys to move 
between entries (shapes) 

Handy to Know… 

 To display and hide the Text pane, click on 
the SmartArt graphic to display its 
placeholder, then click on the SmartArt 
Tools: Design tab and click on Text Pane in 
the Create Graphic group. 

 You can add a shape by pressing  in the 

text pane. 

3 
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INDENTING TEXT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When adding text to a SmartArt shape, you may 
want to indent text so that you can create a list or 
simply an indented paragraph. Fortunately 
indenting text in a SmartArt shape is easy. By 

using the text pane you can create indented text by 
pressing , as demonstrated in the exercise 

below. 
 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
SmartArt_3.docx... 

 
Ensure the SmartArt 
graphic is selected and the 
Text pane is displayed, 
then click after the word 
Research  

 
Press , type Location, 

then press   to indent 

the word Location under 
Research 

 
Press , type Budget, 

then press  again and 

type Type 

 
In the Text pane, click 
after Pre-Construction 
and repeat steps 2 and 3 
to enter the list as shown 

 
In the Text pane, click 
after Site Works and 
repeat steps 2 and 3 to 
enter the list as shown 

 
Click on Close at the top 
of the Text pane to close 
the Text pane 

 

2 

For Your Reference… 

To indent text: 

1. In the Text pane press , then press   

2. Type the text as required 

3. Press  to create another indented entry 

Handy to Know… 

 When creating an indented list in a SmartArt 
graphic, you can create further indented 
levels by pressing  +  again. 

 You can outdent indented text by clicking in 
the appropriate bullet in the Text pane and 
pressing  + . 

4 

5 

Sam
ple



Microsoft Word 2016 - Level 3 

© Watsonia Publishing Page 6 Chapter 1 - SmartArt 

CHANGING THE SMARTART STYLE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A quick and easy way to add a professionally 
designed combination of effects to your SmartArt 
graphic is by applying a SmartArt Style. 
SmartArt Styles include fills, edges, shadows, 

line styles, gradients, and 3-D perspectives and are 
applied to the entire SmartArt graphic. You can 
also apply an individual Shape style to one or more 
shapes in your SmartArt graphic.  
 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
SmartArt_4.docx... 

 
Click on the SmartArt 
graphic to select it 

 
Click on the SmartArt 
Tools: Design tab  

 
Click on the More arrow 
for the SmartArt Styles 
gallery in the SmartArt 
Styles group to see the 
styles in the gallery 

 
Point to the various 
options in the gallery 
and notice how Live 
Preview applies the 
style to the SmartArt 
graphic 

 
Under 3-D, click on the 
first option (Polished)  

 
Click in the document to 
deselect the SmartArt 
graphic and view the 
result 

 

3 
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For Your Reference… 

To change the SmartArt style: 

1. Click in the SmartArt graphic to select it 

2. Click on the SmartArt Tools: Design tab 

3. Click on the desired SmartArt Style in the 
SmartArt Styles group 

Handy to Know… 

 If you customise your SmartArt graphic and 
then apply a SmartArt Style that formats the 
same aspects of your document, your 
customisation will be lost.  

 The SmartArt Styles that are available 
depend on the underlying document theme. 

Sam
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CHANGING SMARTART COLOURS  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can easily change the colours of the entire 
SmartArt graphic or just one shape in it by using 
the contextual tabs that appear when a SmartArt 
graphic is selected. The SmartArt Tools: 

Design tab contains options that will change the 
entire SmartArt graphic, while the SmartArt Tools: 
Format tab contains options for working on the 
selected shape within the SmartArt graphic.  
 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or 
open the file 
SmartArt_5.docx... 

 
Click on the SmartArt 
graphic to select it 

 
Click on the SmartArt 
Tools: Design tab, then 
click on Change Colours in 
the SmartArt Styles group 
to see a selection of themed 
options 

 
Point to the different options 
to see the options applied to 
the SmartArt graphic in Live 
Preview  

 
Under Accent 2, click on 
Transparent Gradient 
Range – Accent 2  

 
Click on the third large 
rectangle in the SmartArt 
graphic to select it 

 
Click on the SmartArt 
Tools: Format tab, then 
click on the More arrow for 
the Shape Styles gallery in 
the Shape Styles group to 
display the shape gallery  

 
Click on Light 1 Outline 
Coloured Fill – Orange 
Accent 1 

 
Click in the document to 
deselect the SmartArt 
graphic and view the result 

 

2 

4 

For Your Reference… 

To change the colours of a SmartArt graphic: 

1. Click on the SmartArt graphic to select it 

2. Click on the SmartArt Tools: Design tab, 
then click on Change Colours in the 
SmartArt Styles group 

3. Click on a themed colour scheme 

Handy to Know… 

 If you don’t like the formatting that you’ve 
applied to a SmartArt graphic, you can reset 
the image by clicking on Reset Graphic in 
the Reset group on the SmartArt Tools: 

Design tab. 

8 
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CHANGING A SMARTART LAYOUT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As usual with Microsoft features like SmartArt, 
you aren’t locked into a particular style or 
formatting feature. In fact these can easily be 
changed without any threat to or fear of losing 

data. There are dozens and dozens of layouts 
available for your SmartArt, and even though you 
may have entered your text, you can opt for 
another layout at any stage.  
 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the 
file SmartArt_6.docx... 

 
Click on the SmartArt 
graphic to select it 

 
Click on the SmartArt 
Tools: Design tab and 
click on the More 
arrow in the Layouts 
group to see a gallery 
of layout options 

 
Point to the various 
options and notice how 
Live Preview applies 
the settings 

 
Select More Layouts 
to open the Choose a 
SmartArt Graphic 
dialog box 

 
Click on the Process 
category 

 
Scroll down to and 
click on the Staggered 
Process option, as 
shown 

 
Click on [OK] to apply 
this layout to the 
image 

 

2 

For Your Reference… 

To change a SmartArt layout: 

1. Click on the SmartArt graphic to select it 

2. Click on the SmartArt Tools: Design tab, 
then click on a layout in the Layouts group 

Handy to Know… 

 When the font size in one shape shrinks 
because you add more text to a shape in a 
SmartArt graphic, all of the other text in the 
remaining shapes will reduce to the same 
size to keep the SmartArt graphic looking 
consistent and professional. 

6 
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ADDING MORE SHAPES TO SMARTART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once you have created a SmartArt graphic, you 
can manipulate the content and the structure of 
the layout using the Create Graphic group on 
the SmartArt Tools: Design tab. You can add 

extra shapes, promote or demote bullets, add extra 
bullets and even change the alignment of the 
SmartArt graphic between left and right display. 
 

Try This Yourself: 

S
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Continue using the 
previous file with this 
exercise, or open the file 
SmartArt_7.docx... 

 
Click on the SmartArt 
graphic to select it 

 
Click on the 
Pre-Construction 
rectangle in the SmartArt 
graphic to select the shape 

 
Click on the SmartArt 
Tools: Design tab, then 
click on the drop arrow for 
Add Shape in the Create 
Graphic group to display a 
menu of options 

 
Select Add Shape After to 
insert a rectangle shape 
after the selected one 

If the Text Pane is not 
displayed, click on Text 
Pane in the Create Graphic 
group… 

 
Type Plans and press   

 
Press  and type Draw 

up, then press  and 

type Submit for approval 

 
Click on Close to close the 
Text pane, then click in the 
document to deselect the 
SmartArt graphic and see 
the result 

            

3 

For Your Reference… 

To insert another shape into a SmartArt graphic: 

1. Click on a shape in the SmartArt graphic to 
select it 

2. Click on the SmartArt Tools: Design tab, 
then click on the drop arrow for Add Shape 
in the Create Graphic group 

3. Select Add Shape After 

Handy to Know… 

 If you click on Add Shape in the Create 
Graphic group (rather than on its drop 
arrow), a new shape will automatically be 
added after the selected shape. 

 You can delete a shape by selecting it and 
pressing . The remaining SmartArt 

objects will adjust automatically. 
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RESIZING SMARTART 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You may decide that a SmartArt graphic would 
look better somewhere else in a document or 
perhaps you want to change its dimensions on 
the page. You can quickly and easily resize and 

move the entire SmartArt graphic or individual 
elements/shapes. Where possible, Word tries to 
readjust the text within the SmartArt graphic to suit 
its new dimensions.  
 

Try This Yourself: 
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Continue using the 
previous file with this 
exercise, or open the file 
SmartArt_8.docx... 

 
Click on the SmartArt 
graphic to select it, then 
click on the Research 
rectangle to select this 
shape 

 
Click on the SmartArt 
Tools: Format tab, then 
click twice on the Larger 
command in the Shapes 
group to increase the size 
of the shape 

 
Click on a white area of 
the SmartArt canvas 
(background) to deselect 
the specific shape 

 
Click on Shape Fill in the 
Shape Styles group and 
click on Grey 50%, Text 
2, Lighter 60% to recolour 
the background 

 
Ensure that the 
background is still 
selected, then click on the 
value in Height in the 
Size group and type 10 

 
Click in the value in Width 
in the Size group, type 14 

and press  

 
Click in the document to 
deselect the SmartArt 

 

2 
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For Your Reference… 

To resize SmartArt elements: 

1. Click on the SmartArt Tools: Format tab 

2. Click on Larger or Smaller in the Shapes 
group for selected shapes, or 

 Click on Height and/or Width in the Size 
group for the entire SmartArt graphic 

Handy to Know… 

 You can resize SmartArt elements by 
dragging the selection handles that appear 
when a shape is selected in the SmartArt 
graphic. 

7 Sam
ple



Microsoft Word 2016 - Level 3 

© Watsonia Publishing Page 11 Chapter 2 - Table of Contents 

CHAPTER 2 TABLE OF CONTENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of tables of contents 

 learn how to insert a built-in table of contents 

 learn how to navigate with a table of contents 

 learn how to update page numbers 

 learn how to update a table of contents 

 learn how to customise a table of contents 

 learn how to format a table of contents. 

A table of contents is inserted towards the beginning of the 
document as a list of the headings in the document, and is designed 
to help readers navigate to relevant parts of the document. A table 
of contents will also include the page number of the heading. 

In Word you can generate a table of contents that will update 
automatically, as long as you have applied the relevant styles to 
your headings.  

INFOCUS 
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UNDERSTANDING TABLES OF CONTENTS 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

A table of contents is located near the beginning 
of a document and contains a list of headings 
within that document, as well as a page number 
reference for each heading. A table of contents 

enables a reader to easily navigate the document 
and is particularly useful in long documents. It can 
be updated automatically when changes have been 
made to the document. 

Understanding Styles And Tables Of Contents 

To understand how Word generates a table of contents, you must also have an understanding of styles 
and how they enable you to quickly insert and update a table of contents. 

Word will generate a table of contents by looking for any headings (or text) that have the default 
Heading styles applied, such as Heading 1, Heading 2, and so on. 

These nine levels of default Heading styles offer nine levels of headings and subheadings that you can 
include in a table of contents. You can also choose which of these heading levels (that is, how many 
levels) you want to include in the table of contents. You can find Word’s default Heading styles in the 
Styles group on the Home tab, and these can be modified to suit the requirements of the document. 

The default Heading styles are contained within the Normal.dotm template, so any document that you 
create based on this template will contain these default styles. If you have developed your own template 
and these styles no longer exist in the template, make sure to rename the existing heading styles as 
Heading 1, Heading 2 and so on, so that Word can recognise these for inclusion in the table of 
contents. Alternatively, you may prefer to copy the default Heading styles from Normal.dotm and 
modify them as required. To copy styles between templates and documents, click on the Developer tab, 
then click on Document Template to display the Templates and Add-Ins dialog box. Click on 
[Organiser], and ensure that the styles list for Normal.dotm appears in the right pane. Select the 
headings styles in Normal.dotm, then click on [Copy] to copy the styles to the current template or 
document. Click on [Close] when finished. 

You can also assign custom styles to levels where you are required to use, for instance, in-house styles. 
Do this by clicking on [Options] in the Table of Contents dialog box, then assigning a level (1, 2, 3 and 
so on) to the relevant custom style. 

 
Options For Inserting A Table Of Contents 

Word provides two methods for inserting a table 
of contents into a document: you can use a 
predesigned table of contents, which produces 
an accurate but fairly limited result, or you can 
create a table of contents using the Table of 
Contents dialog box. 

The Table of Contents dialog box is a more 
advanced method and offers you greater control 
over the content and appearance of the table of 
contents. To customise the table of contents 
(e.g. specify the number of heading levels to 
use, select an alternate tab leader character, 
change the style of the text in the table of 
contents) you will need to use the Table of 

Contents dialog box. 
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